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Legal notice

ERA 2.0 is supported by MS Windows 9x/2000/XP operating systems. It is distributed as a self-
extracting archive containing all the files needed by ERA to run. Note however, that Borland Delphi
compiler is necessary to compile models, so that ERA cannot be legally used without having a legal
copy of Borland Delphi installed on your computer. Usually some versions of Borland Delphi can
be downloaded for free from www.borland.com

Installation

Simply run and extract the SFX archive into afolder of your choice. The install path must not
contain spaces, i.e. it can be c\era), but not c:\Program Files\era\. This limitation is caused by
Delphi compiler requirements. When it is done ERA can be run by era20.exe program.

When the program is run first time following configuration must be done: In the Tools menu choose
Preferences. Following window will display:

Preferences

Compiler |§eries I Eepnrtl I ath I

Fazcal [Delphi]
DCC32EXE IE:'&B orlandhDelphid'Bindcc32 exe Browsze ... |

[+ Compile on Load

[V Enable Source Preview

In the Compiler page of the window the path to the Delphi compiler dcc32.exe must be set. You can
choose path to the dcc32.exe in the directory where you installed ERA if you have alega copy of
Delphi installed on your computer.
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User Interface
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ERA can be controlled like most other Windows applications by Menu and Toolbar. Input and
output information is exchanged between the user and program via Settings notebook and the Main
notebook. Both notebooks have a number of pages. Message window is used for displaying nor
critical messages during computation.

Menu

L ERA 2D

File Edit “iew Model Compute Tools

File Menu
File menu contains commands for data and modd files management. New Data
A0 el DA ES File and New Model File command are used to create a new table of experimental
%—' e data and new modé file. The files can be saved or opened by commands Save
o Do . Data File, Save Modd File, Open Data File, Open model File, Save Data File As,

and Save Modd File As.

] Mew Model File
¥ Open Model File

8 5 ave Model File Submenu Report contain commands for creating reports. Reports can be
Saye Model File s ... printed, previewed or saved in RTF format. Also Fitchart can be exported by
Biepart » | Export... (as Enhanced Metafile) or printed by Print... command.
Fitchart L4
Exit
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Edit Menu
o Edit menu contains standard functions for clipboard support Copy, Cut, Pastea
BT Dclete Their functions are somewhat bugged and they do not work in all
gl‘t controls. It is recommended to use shortcuts Ctrl+C, Ctrl+X, Ctrl+V and Del
= that works well.
Fitchart Properties... command is used to display a dialog window, where the
chart and axes descriptions and scales can be customized.
View Menu

Fit Chart Properties ...

View menu contain two toggles that can be turned on or off. Paint Limit
Curve toggles display of confidence limit curves (see later). Design Mode
toggles the display of results of sequentia design of experiments.

PBaint Limit Curve

Dezign Mode

Model Menu
: Model menu supports the development of the mathematical model.
Generate Source Preview .
WJ Generate Source Preview command create a source code of the model
e library in Pascal language from model equations written in the Model
page in the Main notebook and placesit in the page Source in the
Import Parameters... same notebook. Compile command does the same and then compile

Euport Parameters. ..

source code into the model DLL.
Export Parameters...command exports computed parameter values into the file. Reversibly

the values can be imported by the Import Parameters...command.
Compute menu

3 optimize Compute menu collects commands that can be used to start

® stop computation functions provided by ERA. The most basic function is
Standard Errars Optimize command, that starts optimization of parameters using
Normalized Covariances objective function specified in the Flow page of the Settings notebook,
F-Limit current data and model, and takes parameter values specified in
All F-Limits Parameters page of Settings notebook asinitial estimates of
sutocorelation Tast parameters for non-linear optimization. The computation proceeds until

it is stopped by Stop command.

Sandard Errors and Normalized Covariances commands starts computations of standard
errors of parameter estimates (optimization must be performed before these functions) and
normalized covariances (correlation coefficients) among parameters. Confidence limits for al
parameters can be computed by All-F Limits command. Single confidence limit can be computed by
the command F-Limit if avalid cell in table on the Parameter Details page of the Main Notebook is
selected (any cell in the Lo-F Limit or Hi-F Limit columns).

Tools Menu

Design Next Point...command in the Tools menu displays a dialog
window for the sequential design of experiments support. Preferences
Preferences ... command brings on the preferences window used to change program
settings. Preferences dialog is described in details further in the manual.

Deszign nest point ...

Toolbar
Toolbar contains shortcut commands to most frequently used commands in the menu.

Settings Notebook
This notebook consists of Dimension, Parameters, and Flow pages. Their description follows:

Dimension Page
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Controls at the Dimension page must be used to specify the dimension of the problem. Each value

.............................

i Dimenszion I F'arameters! Flew I

=11 Independent
=11 Dependent
E «periment:

i’i_ Ewventz

Model E guations:
=10 Differential

Model Properties:

iﬁ— Farameters

Dimension I:'EITEII'I'IEtETSIFI:::W I

Walue

1. 1.0000000
al 1.0000000
= 1.0000000
4, 1.0000000
a. 1.0000000
. 1.0000000
i 1.0000000
8.
9,

10,

il

1.2

akaf

=

||

can be set either by the couple of arrows in the left or edited by the
attached edit box.

Variables section allows setting the number of independent
variables and dependent variables } responses. Number of
experiments can be specified in the Experiment/Eventsfield.
Number of algebraic and differential equations can be specified in
Differential and Algebraic fields in Model Equations section and
the number of parametersis specified in Parameters fied.

Parameters Page

This page contains the actual parameter values. The number of
active fields corresponds to the number of parameters specified in
Dimension page. The parameter values on this page are bound to
the values on the Parameter Details page in the Main notebook —
the values at these two locations are always the same. They both
are also bound to the plot displayed on Fitchart page — whenever
parameter values update, either by user or the program, the fitchart
redraws. Therefore, there are two uses of the parameter values on
this page. It can be used for setting initial parameter estimates and
after optimization optimal parameter values can be read there.

For international users. Numeric values must be given in proper format
corresponding to that specified in windows regional settings (usually . or ;). This

©

rule applies for all numeric fields with the only exception being the Model page of
the Main notebook, where the numbers in model equations must be given with

decimal point regardless the Windows settings. Scientific format (e.g. 1.256E-7) is

also allowed.
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Flow page
Dimensiun] Parameters F|'I'W Dimensinnl Parameters  Flow |
Optirization  F-Test | Dptimization |E F-Testi
Objective function: Computation Focus:
Parameter. | 1 Limit: | Lower
biodel Calls: Lirnit Objective:
Tatal | 0.05487657550
Successful Current Objective:
L _ beir: | 006053178079
Objective Funchtion Type
* Sum of Squares Descent | 0.0025183
" Bow-Draper
" “wWeighted 55

Flow page provides the status information about the computation flow. Depending on the setting of
the Optimization/F-test toggle displays the info on optimization or computation of confidence limits
(these two tasks are potentially time consuming). When in Optimize mode it display information
about attained minimum of Objective Function, number of Model Calls, and Successful
aproximations. It also alows to change objective function type to following options:
Sum of Squares — minimizes the sum of squares of residual deviations, good for most
applications
Box-Draper determinant — minimizes complex objective function proposed in Box, G. E. P. &
Draper, N. R. (1965) Biometrika 52, 355. It can be used if the assumption of independent errors
in experimental points is not valid.
Weighted sum of squares — minimizes the weighted sum of squares of residual deviations.
Weights are different for each response and equal to that response maximum. Therefore it may
be usefull if the assumption of constant variance of relative errors is more valid than the
assumption of constant variance of absolute errors
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Main notebook

Data page

Data IM-:n:IeII Snurcel Fit Ehartl ParameterDetailsI Envariancesl Flepnrtl

x(1] | ovinl | vzl | viml | w4l | visl | viel | ﬂﬂ

1. 0.00000 1.00000 000000 0.00000) 000000

2. 2.00000 089200 002400 0.01200 0.00700

2. 5.00000) 065100 0.29500 0.04200 O0.02200

4,1 10,0000 044600 044500 0.03100 0.095600

S.| 20.0000) 0.19300 054200 0.02800 0.22300

.| 25.0000 0.06000 # ) 0.03700 0432600

7. 55,0000 0.00100 0.,25900 002900 071100

g2.| 20,0000 000000 002400 000000 097600

Q,

10,

12, -
| LI_I

Data page contain atable of experimenta data. Column headers indicate the number of variable and
whether it is independent (X) or dependent (Y) variable. The number of columns for independent
variables corresponds to the number of independent variables specified on Dimension page of the
Settings notebook. Cells that are active according to the dimension settings are marked by a #
symbol. These cells can be edited. It is not necessary to fill all dependent variable cells the data
matrix can be sparse and can contain missing datafield (e.g. y[2] in 6. row on picture above).

@ It is important to have sorted data rows by ascending value of independent variable.

The data table support clipboard operations on cells and block of cells. For instance the data from
Excel can be quickly copied to the data table via clipboard. When pasting clipboard content into the
data table make sure that the upper left cell of the block which you wish to paste data into is
selected AND focused:

211 | v

1. EI.EIEIEIEIEIE 0

2. 1.00000 o2
— ThisisO.K.

1] Y1
1| oooooo o

2. 1.00000 0.2
- — - - Thedatatableis not focused (any other control is active)

H[1] 1
1. {00000 01
2. 1.00000 2 L _ . : : :
The grid isin the cell edit mode (clipboard will paste into this cell)
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Model and Source pages

Data  Model |S|:uur|:e| Fit Ehartl Farameter Detalls Envariancesl Hepu:urtl

lancquage = pascal I

declar
rl, r2, 3, rd, x5 : Double:
end declar

static
end static

dyhamnic

ES = ¥[1] + p[51*¥[2] + p[61*¥[3] + p[7]1%¥[4]:

£l = p[l]*¥[1]/5;

2 1= pl2]*¥[1]/c5;

3 = p[3]¥¥[2]"p[5] 52

rd = pl4]*¥[3]"p[6] L5 e
dy[1l] := -rl - rZ:

dy[2] = rl - r3:

Awr=l == r? — vd- hd

Mode page contains a field where the model must be specified. Model syntax is described in
separate section.
Drata | Model Source | Fit Chart | Farameter Detalls | Covanances I R epart I

Library cinn: =
1uzes Math:

type T20WVector = array[0..20] of Doubhle:

type TH0Vector = array[0..50] of Doubhle:

type T20x500Matrix = array[0..500] of T20Wector;
type TH50x500Matrix = array[0..500] of TS0Wector;
type P20Vector = ~TZ0Vector:

type PLS0Vector = ~T50Vector:

type P20x500Matrix = ~TZ0x500Matrix:

type PS0x500Matrix = ~TS50x500Matrix:

procedure DynamicEquations(wvar p,x : P2Z0Vector; war ¥,.dy : Pi0Vect
var

-
4| | *

Source page contains preview of the PASCAL source generated by Generate Source Preview or
Compile commands. It is only for information and debugging purposes and can be hidden in
Preferences.
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Fit Chart page
Data | Mndell Source  Fit Chart ParameterDetaiIsI Envariancesl Hepu:urtl

1.00

C

(.50

0.00 450 90.0
Time. s

Fit Chart page shows the comparison of experimental data (points) and model solution (curves).

Captions, fonts, and scales can be set by choosing Fitchart Properties...in the context (right-click)

menu. Points and curves attributes can be set in Peferences.
Parameter Details page

Data I I'--1::u:|e|| Snurcel Fit Chart Parameter Details I Euvariancesl Hepu:urtl

Walue | Min | SR | Std. Errar | Lo F-Limnit Hi F-Limﬂ
i, 0.07416 0.00010 11.0000
2, 0.00937 0.00010 11.0000
3. 0.01764 0.00o010 11.0000
4, 0.09934 0.00010 11.0000
3, 1.29093 0.00010 11.0000
= 0.230585 0.00010 11.0000
7. 0.25891 0.00o010 11.0000
9,
10,
11.
12,
13, ;l

Parameter Details page numerical input/output information about parameters. Columns indicate
(from left to right) parameter value, allowed minimum and maximum, standard error and lower and
upper confidence limits. First three columns are editable. The table support clipboard operations.




ERA 2.0

Covariances page
[Data I MDI:IEII SDurceI Fit Ehartl Parameter Details  Covariances |F|epnrt|

. | 2 | 3 | &+ | s | e | 72 | s | a | 10| 11.ﬂ
1.1 1.00 -0.20 -0.48 0.50 0.a7v 052 -0.07
2| 020 1.00 -0.49 0oz 0.05 0.07 -0.40
af 048 1 049 1.00 -0.75 -0.75 0.6a 066
41 040 0oz -0.75 1.00 070 -0.99 -0.25
5| 04a7 0.05 -0.75 n.¥o 1.00 -0E9 -0.25
6| -0.52 0.07 062 -0.99 -0.63 1.00 020
7| -0.07 -0.40 0.6 -0.25 -0.25 0.20 1.00
8.
3.
10.
11. =
i} of
Corvariance matrix determinant = 0.0000353

Covariances page display the matrix of correlation coefficients and its determinant after the
Computation | Normalized covariances was performed. High correlations are marked in red.
Report page

Drata | b odel | Fit Chart | Parameter Detailz | Covanances | Autocorelation  Report |Del:uug |

175746 - 21.10,2002 -~

ERA 2.0 - Report

Moded:  Chere20\rodd\Obr IFCERD mod
Data:  Ciherazliwodas\ObriPCEFD.erd

Objective Function = 0.0378140345469572

Parameter Settings:

Mininmum Init. Est. Maxinmum
1. 0.o0oo0000 1.0000000 10000.000
2. 0.0000000 1.0000000 10000.000

Estimated Parameters:

Yalue Std. Error Lo F-Limit Hi F-Limit
1. 0.0337975 0.0000000 00337975 0.0337975
2. 0.9205499 0.0000000 0.9205499 0.9205499

Mormalized Covariances:

1. 2.
1. 0.0o0 0.00
2. 0.00 0.00
Residuals:
Y1 Y2 Y3 Y4 Y5 Y6 Y7
1. 0.0000 0.0000 0Q.0000 0.0000 0.0000 0.0000 0.0000
2. 0.0388 0.,0103 0,0059 -0,3558 -0.6641 -0.5541 -0.0180 o
b= N NnoAC [alnlinkrin] N Nnh+1c m SAAdAS N A2 N cos 7 N nacA

CObriPCEFD. mod [Saved] Carmpiled

Report page contains the preview of report created by the File | Report | Preview command. Report
can be printed or saved by commands of context menu.

10
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How to create models

Mathematical model must be typed into the field on Model page of the Main notebook. The process
of model development consists in three steps — writing source code, saving source code, and its
compilation.
Writing source code
Currently the only supported model constructing language is derived from the PASCAL language.
However, it is possible that different languages and compilers will be supported in future and
therefore the language must be specified — in the very beginning of the source code must be written:
| anguage=pascal
Next part of the source code alows to define user-defined variables. It is marked by following
keywords:
decl ar

end decl ar
the list of declarations that follows must correspond to the PASCAL syntax — list of defined
variables separated by comas, followed by a colon and type identifier and finalized by a semicolon.
For instance three floating point variables a, b, ¢ are defined by:

a, b, c : Double;
After the declaration section follows the section of static code

static

énd static
and section of dynamic code
dynam c

end dynam c
Last two parts can contain model equations. Whenever the model is solved the static equations are
evaluated at first and then dynamic equations are evaluated in all experimental points, as needed by
integration method, or by demands of graphic engine.
Static part of code is usually used only if it is necessary to access experimental data
in the model, e.g. if youwish assign parameter to missing/unmeasured experimental
value. The use of this section is quite rare and it is left empty in most cases

/ Section keywords cannot be omited, but the sections can be left empty .

In both the static and dynamic sections can be used user-defined variables. Except them the
following predefined global variables can be used:
< Inthe static section:
< vectorsp, x andy as symbols for parameters, independent variables, and dependent
variables. Indices are given in square brackets, e.g. X[ 1] .
< matricesxe and ye as symbols for matrices of experimental values, e.g. xe[ 1] [ 1] . First
index represents the row and second the column of the data matrix.
<> Inthe dynamic section:
< vectorsp, X, Yy, dy,assymbolsfor parameters, independent variables, dependent
variables, and derivatives of dependent variable by x[1]. It means that dy[1] is shortcut for
dy[1]/dx[1].

11
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When writing equations the syntactic rules of PASCAL language must be followed. Each dependent
variable must be either expressed by exactly one explicit algebraic equation, or specified by exactly
one ordinary differential equation.

Saving and compiling model

Model must be saved by commands in the File menu. Modd file name is used aso as the name of
model function and therefore it cannot contain spaces and must begin with letter or _ (it can contain
digits, but cannot start with a digit). Saved model must be compiled by Model | Compile command.
External compiler performs the model compilation. The information about the compilation progress
is described in the pop-up window.

v CIAWINDOWSY System32hcmd.exe

Temporary hatch file generated succesfully

Running Delphi Compiler

Borland Delphi Uersion 14.8

Copyright <c> 1283.2881 Borland Software Corporation
C:wera2@swodas0brl1 PCEFQ. pas (48>

4? lines, B.88 seconds,. 28296 hytes code. 3145 hytes data.

Finizhed?
Press any key to continue . . .

As soon as the message “Press any key to continue” appears, the compilation is done. The picture
above shows aresult of successful compilation. If it is not successful, the list of error messages is
included among the messages. The window MUST BE CLOSED BY PRESSING ANY KEY after
inspecting the messages. If the window is closed by close button the compiled model is not saved.
Whenever is the model changed it must be saved AND re-compiled to any changes take effect.

Computations

All types of computations described in this section assume that data and model files are already set.

Parameter estimation

The Compute | Optimize command runs the parameter estimation. The estimation runs iteratively
from the initial parameter estimates. If the estimation does not run well you can try to change initid
estimates. Parameter estimation can be interrupted by the Stop command whenever you wish. Also
it can be re-run at arbitrary time. The program provides ability to track changes in parameter
estimates, objective function value and comparison of experimental data with model predictions
throughout the whole optimization process. The updated information is displayed after each
improvement of parameter estimates, which slightly slows whole process but provides detailed
information about the optimization progress. The optimization must be stopped manually when the
changes of objective function are less than desired precision. The description of computation
algorithms can be found in paper Zamostny, P., Belohlav, Z., "A software for regression anaysis of
Kinetic data”’, Comput. Chem. 23, 479 (1999).

12
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Parameter reliability and correlation
The statistical significance and reliability of parameter estimates can be assessed according to
parameters confidence intervals, which are for the k-th parameter computed by equation

L, =b, tt,,,(N) Sé(pckk

where ¢k is element of variance-covariance matrix of parameters C, px estimate of k-th parameter,
tap critical value of Student’s statistics for significance level a, and 52eXID variance of responses. It is
very closely bound with the computation of correlation coefficients (normalized covariances
between parameters) from the non-diagonal elements of matrix C. However, the equation assumes
local linearity of the model around the optimum and therefore it is valid only if this assumption is
accomplished (at least approximately). Since models seldom fill the given assumption, it is
advisable to use more rigorous criterion.

Therefore the ERA package provides an interval estimate based on the rea confidence
region defined by likelihood criterion. The confidence region is the set of all p vectors matching the
criterion bellow

s¢)- % )/p
g )/n-p

where p° is vector of optimal parameter values, p number of parameters, n number of
experimental points, and F,(p, n-p) critical value of F statistic for (1-a) significance level. Instead
of construction of the whole confidence region or its surface, which are extremely time consuming
tasks, only its projections to all parameter axes are computed. Margina points of these projections
are called confidence limits (Belohlav, Z., Zamostny, P., Kluson, P. & Volf, J. (1997) Can. J. Chem.
Engng. 75, 735). Confidence intervals are provided as standard deviations (half-size of confidence
interval) due to their symmetry around optimal value. On the other hand, confidence limits need not

be necessarily symmetric around optimum, so that both upper and lower confidence limits are
provided.

£F,(p.n- p) [1]
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